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Release notes for version 4.0 
 
New Features 

 

- Added display of pitch within reference and localized waveforms for immediate 

visual comparison of gender, frequency range, and intonations. 

- Added display of a sonogram when clicking on the average spectrum in the main 

window. 

- Added new effect racks to the VoiceFX tool: Clipper, Comb Filter, Frequency Shifter, 

Limiter, Resonator, Spectral Delay, Stutter, and Tube. 

- Added a new Remove Files function to remove files that are either too short, too 

quiet, or do not contain any audio data from the project. 

- Added new commands to AltoCLI (command line version): 

o analyze: analyze a project and generate a report 

o correct: analyze a project and correct it. 

o check: give access to the QuickCheck feature to validate the files in folder.  

o synthesize: give access to Alto Studio’s speech synthesizer. 

o voices: list all the voices installed on the machine available for synthesis. 

o info: display information about an Alto Studio project. 

(analyze and correct replace the unique command previously available to make 

its usage more flexible) 

- Added new commands to the Alto Studio plug-in SDK: 

o GetMetaTags: get the metadata associated with a file. 

o SetMetaTags: set the metadata associated with a file. 

o GetScriptInformation: get the script information (text, character, actor) 

associated with a file. 

o SetScriptInformation: set the script information associated with a file. 
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Improvements 
 

- Added visualization of playback position in waveforms in the main window. 

- Added the ability to check more audio properties in the Quick Check tool. These have 

been added: file type, average loudness, loudness range, peak loudness, total 

duration of file, as well as duration of leading and trailing silences. 

- Added the possibility to load/save the settings of the Quick Check tool. 

- Removed import from FMOD Designer and added import from FMOD Studio instead. 

- Updated ADX2 support to import and export version 3.x projects. 

- Updated Wwise support to latest version to import / export projects. 

- Added messages when trying to edit a file and the audio editor was not configured 

or could not be found (i.e., it had been moved or uninstalled). 

- The search function in the report panel is now case-insensitive. 

- Added playback of the localized file from the project tree with Ctrl + Space. 

- Added a warning message when correcting files and writing them into a flat 

structure (files with the same name would be overwritten).   

- Improved the layout of the progress window. 

- Added access to the VoiceFX manual and the software EULA from the help menu. 

- Improved “About…” window with clearer information and links to social accounts. 

- New splash screen system. 

- New licensing system with automatic registration. 

- New lighter, multilingual installer. 

- Added new Japanese manuals. 

 

 

Bug Fixes 

 

- Fixed a bug where extra files were not always correctly reported. 

- Fixed a bug where very short sounds (too short to calculate loudness) were replaced 

by silence during correction. 

- Fixed some issues when attempting to import / export Excel files if Excel was not 

installed on the machine. 

- Fixed a bug when the reference and localized files had a different sample rate: the 

values displayed for the center frequency and bandwidth of the spectrum bands 

would be wrong. 

- Fixed a bug where an error message could be displayed when trying to read the 

documentation from the tool, even if a PDF reader was installed. 

- Fixed a bug in the project tree, where pressing Ctrl+Shift+Enter opened the 

reference file in the audio editor, instead of showing it in the File Explorer. 
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- Fixed a bug in the Find Files window where the shortcuts to play or open a file may 

have stopped working due to lost focus. 

- Pressing Escape can now close the VoiceFX and About windows, like the others. 

- Fixed a bug where the settings window was not displayed before a correction 

initiated from the menu (instead of the command panel). 

- Fixed a crash when opening the Project Information window on some environments 

if the project file was on a network drive. 

- Fixed an issue where the drag and drop of Alto Studio projects (or importable 

projects such as Wwise, ADX2, FMOD Studio etc.) on the main window did not work 

anymore. 

- Fixed a bug where after loading a new project, the Conform or Correct commands of 

the Processing menu could stay enabled if an analysis or comparison was previously 

performed.  

- Fixed an issue where folder selection dialogs let the user click in the background 

windows. 

- Fixed a bug where Alto Studio would not start if it was installed, launched at least 

once, and then the regional settings of the machine were changed. 
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Release notes for version 3.2 
 
New Features 

 

- This version focuses on the addition of VoiceFX, Tsugi’s technology for vocal 

processing, to the Alto Studio Tools menu.   

- VoiceFX makes it possible to easily create robot, alien or monster voices and to 

simulate other effects such as radio transmissions or stadium announces. 

- All the dialogue lines of a project (or only the ones in a given language, or spoken by 

a specific character) can be quickly batch-processed. 

- VoiceFX processing chains are built intuitively by stacking effect racks. 

- Among the effects available are: chorus, compressor / limiter, convolver, degrader, 

delay, droid, graphic equalizer, filter, flanger, formant filter, gain, mixer, pitch shifter, 

reverb, ring modulator, saturator and vocoder. 

- The parameters of these effect racks can be modulated by envelopes and low 

frequency oscillators (LFOs). 

- The audio files being processed can be analyzed and their amplitude, pitch and 

noisiness curves used as modulation sources as well, allowing for the creation of rich 

and evolving timbres. 

- A separate VoiceFX User Manual is added in the Start menu during installation.  
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Release notes for version 3.1  
 
New Features 

 

- Now includes support for script lines and character names. 

o When creating an Excel file project, it is possible to specify columns used for 

script lines and for character names. 

o When analyzing and correcting audio files, it is now possible to select both 

the language and the character of interest. 

o The Batch Renamer, Loudness Equalizer, Batch Processing with AudioBot and 

LipSync with FaceFX tools now all allow the selection of files based on 

language and character.  

o In the Waveform view, the script line and character associated with an audio 

file are displayed when available. 

- There is now a full public SDK package with an installer (separate download). 

- It is now possible to create the right type of Alto project simply by dragging and 

dropping an ADX2, Fabric, FMOD or Wwise project or an Excel worksheet from 

Windows Explorer to Alto’s main window. 

- New exporters for Wwise and ADX2 game audio middleware have been added. They 

allow for the automatic creation of work units and containers and the import of 

wave files. If present, script lines and characters are added as comments.  

 

 

Improvements 
 

- In single-language report, it is now possible to go to waveform view, open a sound in 

the default editor, or show the file in its folder (like in multi-language report).  

- The Speech Synthesizer has now an option to get lines of text from a Final Draft 

script (either in fdx format or as tabulated dialogue file). 

- In the Speech Synthesizer, when importing from Excel, it is now possible to select the 

column in which the text is (and also a column for an optional character name). 

- The Speech Synthesizer now supports different voices for different characters.  

- In Speech Synthesizer, there is now an option to include the name of the character 

speaking a line in the name of the file generated. 

- The Speech Synthesizer now shows a tooltip with the full text of the line to 

synthesize. 

- In Speech Synthesizer, there is now an option to ignore the first row when importing 

lines from an Excel worksheet. 



 

 
6 

 

 
Koshimura building, 3-5-8 Yoneyama 

Chuo-ku, 950-0916 Niigata City, Japan 
www.tsugi-studio.com 

 

- Added the possibility to select the CueSheets of interest during the import of an 

ADX2 project.  

- It is now possible to ignore the Categories during the import of an ADX2 project.    

- Updated the game audio middleware importers to support the latest versions of 

Wwise (up to 2017.x) and ADX2 (up to AtomCraft version 2.3x). 

- The CSV importer plug-in now also accepts semicolons as delimiters. Semicolons are 

sometimes used in locales using the comma as a decimal separator. 

- Exporting Excel reports is now a lot faster (from x4 to x20 depending on the data). 

- Adding a very large number of files to the project is a lot faster and uses less memory.  

- Added a default folder for FaceFX actors in the Settings window. 

 

 

Bug Fixes 
 

- Fixed a bug preventing to use the demo if a port used by the licensing manager was 

blocked by a firewall.  

- Fixed a bug displaying a shifted spectrum in the main window when the audio data 

was not monophonic.  

- Fixed a bug when importing an Excel workbook where in some cases Excel was 

launched, loaded the workbook and asked if it should be saved. 

- Fixed a bug when importing an Excel project having duplicate reference files. There is 

now a message inviting the user to make sure that the paths to the reference files 

are unique before reimporting. 

- Fixed a bug in the Batch Renamer “Remove” module if several reference files were 

missing (for example if the project was built by importing an Excel workbook). There 

was no problem if only one was missing. 

- Fixed a bug in the CSV importer plug-in if the file was already open in another 

application. A message now invites the user to close the file in the other application 

first. 

- Fixed a bug that prevented to enter a decimal value for the in/out silence durations 

in the single-language correction window. 
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Release notes for version 3.0  
 
New Features 

 

- Alto becomes Alto Studio! 

- Possibility to create a single-language project (can be switched to a multi-language 

project later). 

- New single-language analysis function (no comparison with files in other languages) 

- New single-language correction function: files will match user settings instead of 

reference files. 

- Added a report mode where one can see all the information about all the files in a 

given language (not only the errors). 

- New Batch Processing feature working in conjunction with Tsugi’s AudioBot. An 

AudioBot project will be automatically created, referencing the files in Alto Studio as 

well as an optional AudioBot plug-in chain to apply. AudioBot is then started. Note 

that this feature requires AudioBot 1.1 or higher.  

- New Project Launcher to quickly create and load a project once Alto Studio is started 

and to get information about new updates etc… 

- New “Project Export” command to export lists of files in different languages into an 

Excel workbook.  

- New type of plug-in added to the Alto plug-in SDK: “Exporter plug-ins” can export 

Alto Studio’s dialogue lines towards third-party or proprietary tools. 

- New XML Exporter plug-in. 

- Interfaces with FaceFX™ to automatically generate lip-synced animations. 

 

 

Improvements 

 

- Added the possibility to click on section headers of the analysis or correction settings 

windows to include / exclude all the analyses / corrections of a section at once. 

- In the Speech Synthesizer tool, added an option to name the file generated based on 

the chosen language and the name of the reference files in the project. 

- When referencing a folder, it now possible to copy / paste a path instead of browsing 

to it. 

- Now displays the list of files that could not be processed due to low access privileges 

or read-only status. 

- In the Settings window, added a default folder for samples. 
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- The last sample path is now memorized for the following functions: Batch Renamer, 

Loudness Equalizer and Batch Processing. 

- Added a popup menu to the project tree with functions to open reference and 

localize files in an external editor (until now only available through shortcuts) and 

- The last position of the split bar in the main window is now saved when exiting Alto.  

- Added support for AtomCraft projects versions 2.24 and higher.  

- Added support for Wwise project versions 2016.x. 

- Importing lines from an Excel file in the Speech Synthesizer tool is now a lot faster.  

- Added warning message if all files have been excluded from analysis and attempting 

to start an analysis. 

- Report files are generated on the basis of which tabs are selected on the on-screen 

report (previously all the data analyzed was always reported).  

- Added a tooltip showing the full path of a file in the Batch Renamer tool. 

 

 

Bug Fixes 
 

- Fixed a bug preventing to enter floating point values for the analysis parameters in 

certain locales.  

- Fixed a bug when trying to open the help files from the menu and Acrobat reader 

was not installed on the machine. 

- Fixed a bug when trying to export a line of dialogue from the Interactive Dialogue 

Tester in MP3 with a sample rate non-supported by MPEG1-Audio Layer III (and the 

equivalent for Ogg Vorbis). 

- Fixed a bug when trying to export a line of dialogue from the Interactive Dialogue 

Tester in Ogg Vorbis (bitrate incorrectly calculated). 

- Fixed a bug where the arrow keys were not working in the project tree for very large 

projects. 

- When using the Batch Renamer tool without an Alto project open, it was not 

possible to delete the last batch renaming preset. 

- Fixed a bug preventing to import an ADX2 project built in AtomCraft 2.19.xxx if the 

reference files were not saved in a subfolder but the localized files were. 

- Fixed a bug in ADX2 project import: if there was a backup of an older version of the 

project in the project root folder, the work units in the backup folder were also 

searched for dialogue, potentially duplicating some references in the Alto project. 

- Fixed a graphic bug where the titles of the plug-ins didn’t appear in their parameter 

window (only in versions 2.1.x. and only if the GUI was auto-generated). 

- When opening an Alto project by double-clicking on its file, if some of the files could 

not be found, the warning message was displayed behind the main window. 
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- Fixed a bug in the Fabric importer when mixing relative and absolute paths for the 

language folders. 

- The “Find Files” function now clears the last results pane if the most recent search 

cannot find any file. 

- Creating an Excel report with more than 66530 files was failing due a limit to the 

number of hyperlinks that can be in an Excel sheet. If there are more than 66530 

files, Alto will stop creating hyperlinks for them. 

- Fixed a path issue for localized files on servers. 

- In some very rare cases, moving the mouse over the spectral representation of an 

audio file in the main window triggered an error. 

- An exception was triggered if after importing a game audio middleware project, the 

folder was moved and the “Synchronize” function was called. 

  



 

 
10 

 

 
Koshimura building, 3-5-8 Yoneyama 

Chuo-ku, 950-0916 Niigata City, Japan 
www.tsugi-studio.com 

 

Release notes for version 2.1 

 
New Features 

 

- New support for multi-core architectures for faster analysis. 

- New loudness range analysis (conform to LRA in EBU R 128). 

- New pitch analysis: replaces the spectral centroid and allows the detection of pitch 

differences between two files with more accuracy.  

- New search function to look for dialogue files by name, size, editing date but also by 

audio characteristics (sample rate, bit depth, number of channels or duration). 

- New function that generates run-time IDs for the dialogue lines, with various options 

for different programming languages. 

- New tool to quickly check the presence and the audio characteristics of a group of 

files (for example for the reference files). 

 

 

Improvements 
 

- Added clipping to the Loudness Equalizer tool. 3 modes are available: clipping, 

clipping + display of a warning message or abort if clipping is required.   

- Tool plug-ins can now access Alto’s internal DSP functions and calculate the loudness 

(LKFS), the loudness range (LRA), true peaks (dBTP), the root mean square (RMS), the 

loudness in equidistant spectral bands, as well as extract the spectrum and the 

amplitude or pitch envelopes. They can also correct the loudness. 

- Importer and Tool plug-ins can provide their own logo to be displayed by the user 

interface. 

- Importer and Tool plug-ins can use a new “Languages” parameter attribute that 

creates a special language selection list box.  

- The old-style folder browser windows have been replaced by more convenient ones. 

- Folder project: if subfolders are detected under the project’s root folder, languages 

can be automatically added to the project for each of them. 

- Excel project: if only relative paths are provided, Alto will now look for the files in the 

same folder than the Excel workbook. 

- Excel project: sheets marked as invisible in Excel will not appear in the list of sheets 

to pick from. 

- Added an option to the Correction function and to the Loudness Equalizer to choose 

between duplicating a folder hierarchy and creating a flat structure when saving files 

under a new root folder. 
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- Correction settings: the list of excludable files now only contains the files with errors. 

- A message will be displayed if you are trying to run the correction and no error has 

been previously detected by the analysis.  

- The loudness equalizer can now process files shorter than 400 ms (former limit due 

to EBU R 128 specifications). 

- New FAQ document available from the help menu. 

 
 

Bug Fixes 
 

- Fixed a bug where Mp3 and Ogg Vorbis files were not always saved with the right bit 

rate after loudness equalization. 

- Fixed a typo in published reports where “Silence” was sometimes spelled “Silecen”. 

- Fixed a bug preventing to read cells whose content could not be converted to strings 

when importing Excel sheets. 

- Fixed a bug in the Speech Synthesizer: if lines had the exact same text, a single audio 

file would be generated. It may be the case that the text is the same but will have a 

different emphasis in the game, so that different temporary files are needed. 

- If only the missing / extra files analyses are performed, the files attributes are not 

checked and their size and duration is not known, therefore the “Statistics” report 

would display 0 for their respective totals. The display has been removed in that case. 

- In the “Statistics” report, the total size of the localized files was not correct for very 

large projects. 
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Release notes for version 2.0 

 
New Features 

 

- New “Correction” feature: allows the automatic correction of the discrepancies 

found between files in different languages (sample rate, bit depth, number of 

channels, loudness, duration of leading and trailing silences…).  

- Added way to trigger the correction from Alto’s command line version. 

- New “Batch Renamer” tool: uses a system of rules (condition, addition, removal and 

replacement) to rename groups of audio files.  

- New “Loudness Equalizer” tool: can batch-process files so that they all have the 

same loudness. 

- New “Project Information” window available from the “Tools” menu. 

- New tutorial project now installed with Alto and available through the “File” menu. 

- New “Integration notes” document.  

 

 

Improvements 

 

- Added keyboard control to the combo boxes across the application. 

- Improved scrollbars behavior when clicking on the track but outside of the thumb. 

- Added keyboard shortcuts for commands of the tools menu. 

- Increased the speed of generation of HTML reports. 

- Improved wave file loading: some audio applications don’t save 24-bit wave files 

correctly if they have an odd number of samples (no padding). Alto can now accept 

these files.   

- Improved accuracy of LUFS/LKFS calculations. 

- The CSV Importer plug-in now works with both ANSI and Unicode files. 

- The Speech Synthesizer now accepts ANSI and Unicode files for the dialogue text. 

- All Alto documentations and notes are now available through the “Help” menu. 
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Bug Fixes 

 

- Fixed a bug where loading a project when the current project had been modified was 

not always offering to save.  

- Fixed a bug where it was not possible to play samples in the Interactive Dialogue 

Tester if the Alto project was of type “Folder” and was created from a preset.  

- Fixed a bug where when several dialogue lines were in the Interactive Dialogue 

Tester, the selected one was not always the one played back. 
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Release notes for version 1.2 

 
New Features 
 

- New “Speech Synthesizer” tool:  uses the Microsoft Speech Synthesizer to generate 

placeholder dialogue files from text (imported from Excel, CSV or .txt files). 

- New plug-in system: allows the integration of Alto with proprietary tools and 

dialogue databases using “importer plug-ins” and “tool plug-ins”. 

- New CSV Importer (example of importer plug-in): imports dialogue files in various 

languages from a CSV file. 

- New Silence Trimmer (example of tool plug-in): removes silence at the beginning and 

at the end of audio files. 

- New command line version of Alto for easy integration with build pipelines. 

 

 

Improvements 
 

- Added the possibility to exclude some files from the analysis. 

- Added a “recent projects” menu command to re-open recently used projects. 

 

 

Bug Fixes 

 

- Folder Projects: using presets would sometime prevent the files to be correctly 

imported.  
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Release notes for version 1.1 

 

New Features 

 

- New “Interactive Dialogue Tester”: ensures that concatenated dialogue lines sound 

natural in all localized languages. 

- New Fabric importer: gets the dialogue files from a Fabric project (game audio 

middleware from Tazman-Audio). 

 

 

Improvements 

 

- ADX2 Importer: added support for the new version 2.14 of AtomCraft. 

- PDF publishing: now exports reports considerably faster. 

- PDF publishing: detects characters not supported by the PDF exporter and displays 

warning message.  

 

 

Bug Fixes 

 

- ADX2 importer: fixed a bug where reference files were not found if “None” was 

selected for the dialogue category. Correct behavior is that there is no filtering by 

category in that case and therefore all files are imported. 

- Game audio middleware importers: fixed a bug where non-missing files were 

erroneously reported as missing in some cases. 

- Project tree:  fixed a bug when a project only had one dialogue file. Although it 

worked, no parent folder was displayed and the file had the wrong icon. 

- New project: if a project was already present before creating the new project, the 

waveform view was not immediately refreshed.  

- Fixed a bug where double-clicking an .alto file was not loading the project correctly. 


